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1. Conference themes 
 
InPACT welcomes your contribution to the 2012 Conference! To develop the 
conference program we have chosen four main broad-raging themes in 
Applied Psychology, which also covers different interest areas. The themes 
and sub-themes are: 
 

 In CLINICAL PSYCHOLOGY: Emotions and related psychological 

processes; Assessment; Psychotherapy and counselling; Addictive 
behaviours; Eating disorders; Personality disorders; Quality of life and mental 
health; Communication within relationships; Services of mental health; and 
Psychopathology. 
 

 In EDUCATIONAL PSYCHOLOGY: Language and cognitive processes; 

School environment and childhood disorders; Parenting and parenting related 
processes; Learning and technology; Psychology in schools; Intelligence and 
creativity; Motivation in classroom; Perspectives on teaching; Assessment 
and evaluation; and Individual differences in learning. 
 

 In SOCIAL PSYCHOLOGY: Cross-cultural dimensions of mental disorders; 

Employment issues and training; Organizational psychology; Psychology in 
politics and international issues; Social factors in adolescence and its 
development; Social anxiety and self-esteem; Immigration and social policy; 
Self-efficacy and identity development; Parenting and social support; and 
Addiction and stigmatization. 
 

 In LEGAL PSYCHOLOGY: Violence and trauma; Mass-media and 

aggression; Intra-familial violence; Juvenile delinquency; Aggressive 
behaviour in childhood; Internet offending; Working with crime perpetrators; 
Forensic psychology; Violent risk assessment; and Law enforcement and 
stress. 
 
You will be prompted to choose one of these themes/categories when you 
submit your proposal. If your proposal doesn’t fit exactly in these themes you 
can also send it to us, since we may capture other areas of research.  
 
 
 

2. Structure and formatting for general abstracts 
 
An abstract is an extremely important part of the paper because it 
summarizes the entire paper – it’s the front window to show your work to the 
public and must allow the reviewers to make an intelligent decision about its 
acceptance. 
 
Papers must deliver what is projected in the abstracts or represent bona fide 
developments of the same research. Don’t submit a proposal if data is still 
pending. Submissions must represent completed work. The papers must 
report original, previously unpublished findings in the field. 
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In writing the abstract please be quantitative and write clearly – DO NOT 
EXCEED the imposed characters length limit for main text (declared ahead in 
the criteria of each submission type), they are:  

- 200-400 words for oral papers, workshop and roundtable;  
- 250 words for posters, symposium and virtual presentations.  

 
These will give presenters approximately one page long, because accepted 
abstracts will be published in the proceedings book of the conference (the 
written account of what transpired at the meeting), one page per abstract, and 
plus they will be available printed and online. It is assumed authors give 
consent and authorise to publish their abstract. 
 
The initial submitted abstract file must be anonymous (using our templates, 
without giving any information about the authors) – this is a blind peer-review 
process. All papers will be reviewed under the direction of the Scientific 
Committee and must be written in English. 
 
 
 

 
ATTENTION: 
 

You must download our ready-to-edit file template (in .doc format), available 
in our website, and fill in the appropriate spaces, instead of making a new 
document. Download Template A for all types of paper except for Symposium 
contributions – in this case, which require multiple abstracts, we have them 
combine to fill in Template B. 
In your template you will be asked to typewrite the theme and sub-theme 
(consult our “Conference Topics” tab in our website) of your abstract, and the 
type of contribution you are submitting to. Then, in the presented “textbox”, 
you can typewrite your abstract main text. 
 
Formatting text: Replace “text here” messages with the actual writings and 
the headings’ names. Main text should be justified and respecting the word 
count according to your paper contribution. Letter type formatting is: 

- Headings: Times New Roman, 12 pt, bold 

- Text: Times New Roman, 10 pt 
Do not use paragraphs, footnotes, figures, tables or references. Additional 
information can be asked to you later. 
 

 
Titles for the papers should have no more than 15 words and it will be 
provided a section after the abstract main text box to introduce keywords (5 at 
max.). Abstracts should NOT INCLUDE REFERENCES. 
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An abstract main text must have headings according to the type of paper. 
These will be exclusively for Oral papers, Posters, Virtual Presentations and 
Symposium abstracts: 
 
 
 

Empirical papers: 
 
Objectives: Refer the primary goal(s) 
and major hypothesis tested or posed 
research question; 

Review/Theoretical papers: 
 
Purpose of study: Refer the aim or 
primary objectives; 
 

Design: Describes the rationale and 
design for the adopted procedures of 
the study; 

Background: Make a brief concise 
summary of information, placing the 
actual paper in context; 

Methods: Describe the number of 
participants and their selection (in 
case of documentary data, state how 
these were selected), materials and 
methods for data collection and 
analysis. 

Methods: Gives details in assumed 
procedures and their rationale (e.g. 
inclusion/exclusion criteria, literature 
search and methods of analysis), key 
arguments and theoretical positions; 
 

Findings: Present the data (numerical 
and/or textual) kept at a minimum. 
For qualitative analysis describe 
briefly your findings. 
 
 
 

Conclusions and discussion: State 
and discuss conclusions that can be 
drawn from the described work, 
including theoretical, methodological 
or applied/policy implications, as 
appropriate, and any key limitations 
of the study. 

Conclusions: State what can be 
drawn from the study - includes 
theoretical, methodological or 
applied/policy implications as 
appropriate and any key limitations of 
the study. 

 

 
 
 

Specific headings for Symposium Summary, Workshop and 
Roundtable/Debate abstracts are described in the following pages ahead. 
 
 
 

3. Oral Paper Presentations 
 
These kind of papers can include accomplished empirical or theoretical 
research with corresponding results or reports and new developments in the 
given themes, employing qualitative or quantitative methods of either primary 
or secondary data. Keep in mind that the Scientific Committee revisers can 
ask you to submit the short or full paper corresponding to the abstract. 
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3.1. Criteria for Oral Paper submissions 
 
Proposals for oral papers must include (Abstract Template A): 

- Theme/category and sub-theme you are submitting to 

- Title (max. 15 words) 

- Abstract main text (max. 200-400 words) with headings according 
to type of paper (see p. 4) 

- Keywords (max. 5) 
 

3.2. Oral Paper presentations 
 
Each oral paper presentations will be allocated in 20 minutes slots. 
Presenters must give 15 minutes for the presentation itself + 5 minutes for 
discussion with the audience.  
 
Session rooms will have a laptop with software tools (like PowerPoint1), data-
projector and screen. Once your abstract is accepted and your conference 
registration made, you can preload your presentation to us. More info is given 
at the proper time. We recommend presenters to bring an USB pen drive or 
CD-ROM with a back-up copy of their presentations. 
 
 
 

4. Posters 
 
Posters are an alternative format for freestanding research presenters. Poster 
sessions facilitate informal discussion and they can be a more personal form 
for exchange on information than regular oral presentations. A poster contains 
implemented information work about a subject and will be exposed at the 
conference in the exhibition area.  
 
Proposals for poster presentations must also include an abstract besides the 
poster/demonstration itself - only made when the abstract is accepted. They 
must be informative but also engaged visually and easy to understand.  
 

4.1. Criteria for Poster submissions 
 
Proposals for posters must include (Abstract Template A): 

- Theme/category and sub-theme you are submitting to 

- Title (max. 15 words) 

- Abstract main text (max. 250 words) with headings according to 
type of paper (see p. 4) 

- Keywords (max. 5) 
 
Once the abstract for the poster is accepted, presenters are required to 
prepare the content in a full-sized poster, with the following requirements: 

                                            
 
1 PowerPoint® is a trademark of Microsoft Corporation in the United States and/or other countries. 
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- Dimensions: Poster size should be no more than A0 portrait 
(approx. 84 x 115cm). We recommend that you use heavyweight 
paper or thin card. 

- As they can be viewed from a certain distance, please make sure 
your typeface and graphics are easy to read – we recommend you 
to use a font size for: 

o Title: 20-24 mm or 100 point maximum/bold. Make sure your 
title, authors and affiliated institutions/contact details are 
clearly visible at the top of your presentation to give to 
interested delegates. 

o Headings: 48 point suggested 60 point at max. – title case 
headings such as “Introduction”, “Methods”, “Results”, 
“Discussion” and “Conclusions” are useful. Results can be 
presented in the form of graphics, avoiding large data tables 
– use colours, symbols, pictures, etc.  

o Content: 20-28 point, 32 point at max (single spaced). 

- Please note that the official conference language is English – all 
posters must be displayed in English.  

 
Keep the amount of text in your posters brief, focusing on a few key points. 
Any description of the methods should be simple and concise. 
 

4.2. Poster presentations 
 
The conference will include timetabled sessions providing an opportunity for 
presenters and participants to discuss work and findings. There will be a 
dynamic forum between presenter(s) and the audience. Presenter(s) must 
give 2 to 5 minutes oral presentation followed by approx. 3 minutes discussion 
with the public, where they can answer questions about the posters. 
 
Please remember to take your poster materials with you. Any posters 
remaining at the end of the conference will be discarded. 
 
 
 

5. Symposium 
 
A Symposium is a group presentation constituted of papers correlated by a 
common theme. A Chair/Convenor, whom acts as the link person with the 
conference organizers, and is responsible for the symposium submission, 
organizes them. There will be a maximum of 5 presenters (including the 
Chair) and there must be at least two different countries and research groups. 
A named Discussant is optional – in this case there is a maximum of 4 
presenters including the discussant. 

 
5.1. Criteria for Symposium submissions 

 
The Chair of the Symposium submits the “Summary” and each of the 
contributors’ abstracts (Abstract Template B). 
 



 7 

First page is the Symposium “summary” and must include: 

- Theme/category and sub-theme of the symposium session 

- Title of the symposium (max. 15 words) 

- Abstract main text (max. 250 words) with the following headings:  

 Scope of the Symposium (summarizes the aim, extent focus and 
purpose of the symposium) 

 Objectives (what’s expected the session to achieve) 

 Overview of papers (integrating the relevance of the individual 
contributions) 

 Timetable (running order of the individual papers) 

- Keywords (max. 5) 
 
Each contributing abstract is filled in the next pages of the template, 
containing: 

- Title (max. 15 words) 

- Abstract main text (max. 250 words) with headings according to 
type of paper (see p. 3) 

- Keywords (max. 5) 
 
5.2. Symposium presentations 

 
There will be available a total of 100 minutes, each presentation with a 
maximum of 20 minutes. The Chair initiate the session with a brief 
presentation of the symposium and the discussant (optional) provides after 
the sessions an overview of the main issues (about 5-10 minutes max.) and 
facilitates a general discussion of the audience by audience and authors. 
 
 
 

6. Roundtable/Debate 
 
A roundtable or debate provides an opportunity to take forward an issue of 
relevance critiquing current evidence and suggesting future directions for 
research and applications. The format is a series of 4 maximum presentations 
(including Convenor) from different presenters, across two or more 
institutions. A Roundtable should focus on a topical issue and discuss it from 
different perspectives vs. a Debate should focus on one topical issue and 
discuss it from two opposing perspectives. These structured discussions 
should provide an original contribution to the debate in the area.  
 

6.1. Criteria for Roundtable/debate submissions 
 
The proposal must be submitted by the roundtable Convenor and includes 
(Abstract Template A): 

- Theme/category and sub-theme you are submitting to 

- Title (max. 15 words) 

- Abstract main text (max. 200-400 words) with the following 
headings:  

 Purpose (focus to be addressed by the discussion) 
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 Background (concise summary placing session in context, aims of 
the discussion and expectations)  

 Summary (outlines the context or focus of each contributor’s 
approach) 

 Timetable (indicated the running order of the sections) 

- Keywords (max. 5) 
 
6.2. Roundtable/debate presentations 

 
The contributors should provide summaries of their perspectives on the issue 
that are sufficient to enable delegates to be actively involved in the structured 
discussion.  
 
The session should last for 60 minutes with an interactive discussion period. 
The presentations should have a clear structure and require active 
participation with delegates/attendees during the general discussion. They 
should not be unfocussed, informal discussions around a topic. 
 
 
 

7. Workshop 
 
A workshop provides an opportunity for a group of participants to achieve a 
specific goal or address a particular problem. It may be designed to train or 
educate participants in a particular research methodology or theoretical 
approach, e.g., or to address a specific problem, such as how to use 
particular research findings in health psychological care or policy. A workshop 
can also be a useful way to develop a consensus on a particular issue. For 
example, the goal of the workshop may be to produce a position statement or 
policy on a particular topic, to identify priorities in a specific area or to develop 
theoretical perspectives or methodologies. It should have a clear structure 
and require active participation by everyone involved. 
 
Proposals for Workshop will have 5 contributors at maximum, including the 
workshop convenor/facilitator. Workshops will be judged in terms of interest 
and quality and an adequate summary paper. 
 

7.1. Criteria for Workshop submissions 
 
The Convener submits the proposal for a Workshop and the abstract contains 
(Abstract Template A): 

- Theme/category and sub-theme you are submitting to 

- Title 

- Abstract main text (max. 200-400 words) with the following 
headings:  

 Purpose (statement of the problem or goal to be addressed) 

 Background (concise summary placing session in context, aims of 
the workshop and expected outcomes for participants)  
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 Key points (details of key arguments or the skills and activities 
covered)  

 Description of the participants (describe the intended participants 
and their maximum number for the workshop) 

- Keywords (max. 5) 
 

7.2. Workshop presentations 
 
Timing for workshops should not extend 80-100 minutes. Please indicate in 
your submission form if you wish to request a particular length of time for your 
workshop. 
 
 
 

8. Virtual Presentation 
 
The conference will hold a presentation facility prepared not only for common 
posters but also for virtual content - screens will showcase virtual posters, 
PowerPoint and videos. This will give the opportunity for all presenters - those 
who are present and particularly for those who cannot be at the conference 
meeting physically, but wish to participate - to showcase their work through a 
different media.  
 
Presenters that will not be present at the conference, but will participate with a 
virtual contribution, must also be registered in the conference, their papers are 
considered to be published as the others and are also entitled to the 
certificate of participation in the conference. Virtual presentations will work as 
poster content but the media in which it is done and presented is different. 
 

8.1. Criteria for Virtual Presentation submissions 
 
Virtual presenters must, as for all other conference presenters, submit an 
abstract (Abstract Template A), following the rules similar for the poster 
abstracts, which are: 

- Theme/category and sub-theme you are submitting to 

- Title (max. 15 words) 

- Abstract main text (max. 250 words) with headings according to 
type of paper - empirical vs. theoretical (see p.4) 

- Keywords (max. 5) 
 
Once the abstract for the virtual presentation is accepted, presenters are 
required to prepare the content for the presentation itself, which can be made 
in one of these 3 ways (in no particular order): 

1) Recording a video of the presentation, 
2) Creating a PowerPoint presentation with a voice-over, 
3) Creating a "Virtual Poster". 
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8.2. Helpful Hints for a successful Virtual Presentation 
 
1) About recording a video presentation: 

 You can record your presentation through a camcorder, web-camera or 
mobile phone with at least 4 mega pixels quality. 

 Feel free to open your video in an editing program (Windows Movie Maker2, 
iMovie3, AVID4, Final Cut Pro2 or other editing software), according to your 
expertise and convenience, to make alterations and all kind of editing (putting 
a tittle, your name, etc). 

 Save your file either in *.AVI, *.MPG, *.WMV or *.MOV (extensions format). 
 
2) About creating a Powerpoint presentation with a voice-over: 

 Use the PowerPoint program or similar (available in any Operating System) 
to compose your presentation. This software is convenient and easier for 
almost all people, but you're welcome to use other tools, creating advanced 
presentations. 

 We suggest you start by present a picture of yourself with email contact or 
affiliations, with a welcome message to the audience – feel free to use your 
creativity, but try to keep it easy and brief. 

 Use an audio recording device, such as a microphone or other external 
voice recorder, music, etc. Once you have you PowerPoint slides, you can 
insert the audio files using the program itself - click Insert > Movies and 
Sounds > Sound from file (choosing the location of your audio files). 

 You can also record your voice with PowerPoint in each slide, if desired - 
click Insert > Movies and Sounds > Record sound. One can create self-
running slides, including your voice narration. 

 After you made the synchronized PowerPoint presentation, turn it into a 
movie file - click File > Make Movie - the opened window will allow you to 
choose the location where you want to save your video from the PowerPoint 
presentation (save your file either in *.AVI, *.MPG, *.WMV or *.MOV 
(extensions format). 
 
Important note for videos and PowerPoint videos: 
- Spoken or written words must be in English. 
- Try to achieve a good quality voice recording, to facilitate the hearing, by 
making it in a quiet setting and by speaking clearly and in a paused manner. 
- Videos and PowerPoint videos should be kept simple, transmitting 
information clearly, like in a poster presentation with the respective contents. 
Use clear and visible characters in the writings when editing text or topics. 
- Review and watch various times your video and its contents in your software 
player. 
- You MUST NOT EXCEED a 10 to 12 minutes presentation and 2GB of 
space file. 
 

 

                                            
 
2 Windows Movie Maker is a trademark of Microsoft Corporation in the United States and/or other countries. 
3 iMovie and Final Cut Pro application programs are trademarks of Apple Inc., registered in the U.S. and other 
countries. 
4 AVID is a trademark of Avid Technology, Inc. or its subsidiaries in the United States and/or other countries. 
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3) About creating a "Virtual Poster": 

 You can also opt by making a one-slide virtual poster, similarly to a physical 
poster. 

 Using PowerPoint you must choose a format for your slide that will function 
like a poster itself. 

 Add your contents: that must include the title, affiliated institution/contact 
details (clearly visible at the top of the slide) and the headings - "Introduction", 
"Methods", "Results", "Discussion" and "Conclusion" are useful to separate 
the contents. 

 Like in common posters, keep the amount of text brief, concise and focusing 
in the key points. Description of the methods should be simple. Think about 
the construction of the virtual poster like if you were putting the materials in a 
full-sized physical poster. 
 
 
 

9. Exhibitions/Corporate Showcase 
 
The conference enables companies to present recent developments and 
applications, to inform and a large and qualified audience of future directions 
and showcase products and services. There will be a time slot for companies 
to make their presentation. It enables the opportunity to display their offerings 
in tools, services or books, through an exhibition booth. 
 
For further information, please contact our publicity chair: publicity@inpact-
psychologyconference.org. 
 
 

 
10. Submitting through the “Online Submission System” 
 
Submissions are easy to enter through our step-by-step Electronic 
Submission System. Once you are happy with your abstract, properly filled, 
you must upload and enter details for it (make sure all the elements are filled 
or it will be rejected): 
 

1) Fill the “General Information” box. You must type your Submission 
Title; select the Submission Type from Oral papers, Poster, 
Symposium, Roundtable/Debate, Workshop or Virtual Presentation; 
then, you must choose whether Student or Non-student status (student 
submissions must have a full-time student as the primary author and 
be mostly written by students). 

 

2) Fill in the “Authors” box. A chair/convenor contact details must come 
first: fields ask for first and last name, organization/affiliation, country 
and email contact. You can add more authors if necessary. 
 

3) In “Contact Author” you must select which author will be the primary 
contact point for correspondence about the submission and provide an 

mailto:publicity@inpact-psychologyconference.org
mailto:publicity@inpact-psychologyconference.org
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alternative contact. It’s recommended for the chair/convenor to be the 
contact author. 
 

4) Select the “Topic Areas” you are submitting to: select one from the 4 
main areas (Clinical, Educational, Social or Legal Psychology), then 
select the sub-theme(s) corresponding to that main area. 
 

5) In “Content” box is where you upload your File (made from the 
template): in the empty boxes enter the keywords used in your abstract 
and copy + paste your main text from your abstract paper file (made 
from the template) – this action will guarantee your contact details are 
associated with that abstract, while the abstract file maintains 
anonymity for the refereeing procedure. For Symposium sessions, you 
only need to copy + paste the “Summary” of the session and its 
keywords. Next, upload your file and choose file type (it’s preferred that 
you maintain the altered template in .doc format). 
 

6) In “Password” box your will define a password for your Submission ID, 
which you will receive via email upon submitting the entire form. Please 
save your password so you can remember it. Your ID + Password will 
permit to make future changes in the submission. 
 

7) Optionally, use the “Comments” box space to tell us about any extra 
information about your submission. Check your entries carefully, 
making sure everything is filled, and finally click Make Submission 
button. 

 
Once you have submitted your abstract, you will receive an e-mail confirming 
receipt. If you haven’t received an email after 24 hours, please contact the 
conference secretariat on secretariat@inpact-psychologyconference.org. 
 
 
 

11. Refereeing Procedure 
 
Each submission will be reviewed by certain criteria: its contribution to 
knowledge in the areas, if it permits to inform about application of knowledge, 
insight that provides into the issues addressed, the methodological 
thoroughness, originality, clarity and its potential to interest the conference 
audience. 
 
Submission will be blind reviewed by nominees of the Scientific Committee, 
according to the criteria and standards established. If a submission doesn’t 
put in evidence all required elements set out in the submission information 
above, it will be automatically rejected. 
 
If the referees feel that a particular submission serves better a different format 
than the proposed one, authors will be invited to consider an alternative 
format. The refereeing procedure for symposium and workshops submissions 
will be seen as a full package by the merit and importance of any contribution. 

mailto:secretariat@inpact-psychologyconference.org
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Authors will be notified of the referees’ decisions by email. Successful 
contributions will be advised of date and time for their presentations. The 
decision of the referees is final and the conference organizing committee is 
unable to respond to further enquiries once a decision has been made. Every 
effort will have been made to accommodate any timetable constraints notified 
at the time of submissions. Details of the entry to appear in the Conference 
Program will be included in the email. Any errors or amendments must be 
reported by return. Individual presenters in symposia are not contacted 
directly – all correspondence will be conducted through the Chair/Convenor 
who is responsible for keeping presenters informed. 

 
 
 
 
 
 
 


